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Workflow
Welcome to the Helix Application Pilot’s Guide. This guide contains details of the Helix 
application’s features and functionality. All behaviors are the same on Mac® and Windows® 
unless otherwise noted. It is recommended that you also read the Helix Owner’s Manual 
for details on using your device, available from http://line6.com/support/manuals/.

What’s in it for me?
Helix is a simple, but powerful, editor, preset librarian and IR manager application for 
Mac® and Windows®. It allows you to easily customize, backup and manage your tone 
presets and setlists, as well as manage the impulse responses on your Line 6 Helix 
device. 

TIP: Visit the Line 6 Customtone™ site to share your Helix tones and 
download from the huge library of artist and user presets!

Workflow Overview
Once the Helix application is launched, it automatically syncs the complete contents 
of all 8 setlists from your device’s internal memory. You'll see your presets & impulses 
displayed in the LIBRARIAN Window at the left, and your currently loaded preset's 
contents displayed in the EDITOR Window on the right. This allows you to load & 
customize your presets, configure footswitch & controller assignments, create and edit 
snapshots, manage preset & IR locations, as well as backup & restore the entire con-
tents of your Helix device. While connected, communication between the application 
and your Helix device’s internal memory is instantaneous. Changes you make to any 
parameters in the EDITOR, as well as any changes to presets, setlists and IRs within 
the LIBRARIAN, are immediately reflected on the device, and vice-versa.

PRESET

PHONESVOLUMEBYPASSSAVE ACTION

PAGE PAGE

16B Dream Rig Duet

FeedbackTime

Delay  Harmony Delay

LevelMixKey Scale

0.0dB40%MinorD1/8

Scream 808 MODE

EXP 1 EXP 2

H O L D   T O   E D I T

TAPBANK H O L D   F O R   T U N E RNone More Black
16A

Dream Rig Duet
16B

Jimi, Not Jimmy
16C

DAW Remote
16D

BANK Mystery Filter Ubiquitous Vibe Harmony Delay

This interactive communication allows you to tweak your presets and setlists in real 
time, without the need to send/receive or manually sync to the device.

WARNING: Be careful when overwriting presets or impulse responses - 
these changes cannot be reverted!

Computer Connectivity
To put the Helix application to work, connect your Helix device to your computer’s USB 
2.0 or USB 3.0 port to establish two-way communication. If on Windows®, be sure to 
have the latest Helix Driver installed. You can download this at http://line6.com/soft-
ware/, or simply choose to install the driver when you install the Helix application. Exit 
any other Line 6 applications that may be running. With your Helix device powered on, 
launch the Helix application.

•	 On Mac® - go to Applications > Line 6 > Helix
•	 On Windows® (XP, Vista®, 7/8) - go to the Start button menu > Programs > 

Line 6 > Helix
•	 On Windows® (10) - go to the Start button menu > All Apps > Line 6 > Helix

Upon launch, the application will detect Helix hardware and automatically retrieve and 
load its saved presets. This may take a moment to download all of the preset informa-
tion. 

If your Helix device is not USB-connected and powered on, you’ll see the following 
alert, warning you that no device was detected.

Preset Compatibility
This Guide covers version 2.0 of both the Helix application and Helix device firmware 
- be sure to use Line 6 Updater (see page 20) to check and update your device 
firmware. Helix presets that were originally created using previous versions of the Helix 
application and device firmware are supported. Note that, once loaded and/or saved 
with Helix 2.0, your presets will have new information added to them to support the 
version 2.0 features. These "2.0" presets should still continue to be fully functional with 
earlier Helix hardware & software, but backward compatibility cannot be guaranteed. It 
is advised to keep a backup all your pre-2.0 version presets if you plan on returning to 
these earlier device and application versions.

http://line6.com/support/manuals/
http://line6.com/customtone/
http://line6.com/software/
http://line6.com/software/
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GUI Overview
The Helix application has a very simple, easy-to-use interface. When connected, your 
Helix device is displayed at the top left with its current firmware version listed. The navi-
gation is divided into two main sections, the LIBRARIAN window, for managing preset 
and impulse response (IR) files, and the EDITOR window, for customizing all aspects of 
the currently-loaded preset. 

EDITOR WindowLIBRARIAN Window

The Helix main application window is resizable - simply click and drag any corner or 
edge of the window to adjust to the preferred size, or click the "Maximize" button at the 
top of the window to use it in full screen mode.

Application Menus
Above the main application window you'll find the familiar menu bar. To follow are de-
scriptions of the included application menu commands for Mac® and Windows®.

TIP: Many of these commands also have shortcuts assigned - see 
"Keyboard Shortcuts" on page 16.

Helix (Mac® only)
• About Helix - Launches the About box, which includes the software version 

and legal-speak.
• Preferences - Launches the Preferences window, where you can select appli-

cation options - see "Application Preferences" on page 19.
• Quit Helix - Exits the application.

File (Windows® only)
• Preferences - Launches the Preferences window, where you can select appli-

cation options - see "Application Preferences" on page 19.
• Quit - Exits the application.

Window
• Presets - Displays and places focus on the Librarian window - Presets panel.
• IR Manager - Displays and places focus on the Librarian window - Impulses 

panel.
• Editor - Displays and places focus on the Editor window - Home panel.
• Global EQ - Displays and places focus on the Editor window - Global EQ panel.

Help
• Helix Online Help - Takes you to the Line6.com Support site where you can 

find the latest product documentation.
• Helix Application Pilot's Guide - Launches the PDF you are reading now.
• About Helix - (Windows® only) Launches the About box, which includes the 

software version and legal-speak.
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Presets Panel
The PRESETS panel provides all functions for importing, exporting & managing pre-
sets, setlists and backups.

Bundle functions

Setlist functions
Preset functions

Loading Presets
To load a preset on Helix from the application, double-click on the desired preset from 
the PRESETS list view. The preset will load on the connected Helix device.

Importing and Exporting Helix Preset Files

To save an individual Helix preset to your computer, select the preset by single-clicking 
on it in the Librarian - Presets list and click the Export option. This creates a copy of the 
preset from your Helix device memory and saves it to your computer as a Helix preset 
(.hlx) file. The familiar Mac® or Windows® file Save As window is presented, in which 
you can edit the filename and choose a destination folder. By default, all .hlx files are 
saved to:

•	 Mac® - /Documents/Line 6/Tones/Helix/ folder
•	 Windows® - \My Documents\Line 6\Tones\Helix folder

To open a Helix preset file, it is recommended to select an empty preset location (such 
as a "New Preset" within a User setlist) and click the Import button. A brief dialog will 
inform you that importing will overwrite any preset information in the selected loca-
tion. Click Yes to continue. A system window will display a file browser for selecting 
the preset you wish to import. The preset will now reside on your Helix device in the 
selected location.

Renaming, Copying and Pasting Presets
These functions can be performed by clicking the buttons above the PRESETS list view 
and will act upon the selected (highlighted) preset. You can also Right-Click/Ctrl+Click 
on a preset in the list to open a context menu with these same functions (or use the 
app's "Keyboard Shortcuts").

Drag and Drop Presets
It is possible to drag any preset directly from the main PRESETS list view and drop it 
onto your desktop, or into any folder on your computer to copy it there. Or, select mul-
tiple presets to drag and save copies of each in one drop!
Presets can also be dragged and dropped within the PRESETS list view to re-order 
them. When the preset is dropped in the location of the blue highlight bar, the surround-
ing presets are shifted upward or downward accordingly.

Importing and Exporting Setlists

The Helix application allows you to instantly save the currently loaded setlist, including 
all its presets, to a Helix setlist file (.hls). This is very handy for making a backup of all 
presets within a setlist, so that a group of presets can easily be loaded back onto your 
device. 
To export a setlist, click Export Setlist to display the Save As dialog. 
By default, setlists are saved to:

•	 Mac® - /Documents/Line 6/Tones/Helix/Setlists folder
•	 Windows® - \My Documents\Line 6\Tones\Helix\Setlists folder

To import a setlist and load it to your Helix device, click Import Setlist. This will prompt 
you to ensure that you wish to replace the currently selected setlist and the presets 
therein. Continue through the Open window to select the setlist you wish to load onto 
your Helix device.
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Changing Setlists
To change the active setlist shown in the PRESETS list, click on the Setlist combo-box 
control. The currently-selected setlist will be indicated with an “open folder” icon.

Renaming Setlists
To rename the current setlist, Right-Click/Ctrl+Click on the setlist name within the 
Setlist combo-box control list.

Importing and Exporting Helix Bundles

You can use the "Export Bundle" feature in the Helix application to create a copy of all 
your Helix device's presets and their settings as a Helix bundle (.hlb) file, stored on your 
computer - and use the "Import Bundle" feature to load all the presets back to your 
Helix. This makes for a handy way to backup and restore your Helix anytime! Keeping a 
current backup is highly recommended, and it's always a good idea to create a backup 
before doing device firmware updates or making major changes to your preset lists.
Select the Presets tab and click “Export Bundle” to present the Save As dialog.
By default, all .hlb files are saved to:

•	 Mac® - /Documents/Line 6/Tones/Helix/Bundles folder
•	 Windows® - \My Documents\Line 6\Tones\Helix\Bundles folder

Note that the Export Bundle feature always includes all setlists and presets, regardless 
of any preset(s) that might currently be selected within the presets panel.
To restore a bundle to your Helix device, click “Import Bundle.” This will prompt you to 
ensure that you wish to replace all setlists and presets on your Helix device with those 
in the bundle file. Continue through the “Open” window to select the bundle you wish 
to load onto your Helix device.

NOTE: Bundles do not contain any of the Helix device's global settings or 
Impulse Response (IR) files that you have imported to your Helix. You can 
separately export IRs from the Impulses Panel - see "Importing and Exporting 
Impulse Responses" on page 6.
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Impulses Panel
The IMPULSES panel provides a list of all impulse response files (along with their re-
spective ID numbers in the left column) that currently reside on your Helix device.

What are Impulse Responses?
Impulse responses (or “IRs”) that can be used in Helix are .wav files that are the result 
of capturing the sound of a test tone (frequency sweep) through a guitar or bass amp 
speaker cabinet, which has been de-convolved with the original tone signal. This rep-
resents the frequency response of the cabinet itself and can be used to simulate the 
way it alters the sound. This is similar to a convolution reverb, but with a much shorter 
decay.

IR Formats and Restrictions
Helix can import any mono or stereo .wav file IR, regardless of its bit depth, length, or 
sample rate frequency. While this is very convenient, please be careful not to load just 
any .wav file as an IR or you may experience unexpected sonic results. SysEx files are 
not supported by Helix.

Importing and Exporting Impulse Responses
To access the impulse responses stored on your Helix device, click on the IMPULSES 
tab. From here you will be presented with a list of impulse responses and their index 
numbers. Your Helix device will access these IRs by their index only. They are not di-
rectly associated with presets.

To import an IR to an index, first select the desired index location in the application's 
IMPULSES list and click Import. Continue through the Open window to select the de-
sired .wav file you wish to load onto your Helix device. 
To export an IR, click Export to display the Save As dialog.
By default, IRs are saved to:

•	 Mac® - /Documents/Line 6/Tones/Helix/IRs folder
•	 Windows® - \My Documents\Line 6\Tones\Helix\IRs folder

You may also drag and drop to and from the IMPULSES list view to export and import 
IRs - see the following section.

TIP: Exporting your complete list of IRs is a nice way to keep a backup of them 
all in one place on your computer. It is helpful to name your exported IR files with 
their stored index ID number to easily identify how they should match up with an 
exported Helix bundle to make more comprehensive backups.

Renaming, Copying, Pasting & Clearing IRs
These functions can be performed by clicking the buttons above the IMPULSES list 
view and will act upon the selected (highlighted) IR. You can also Right-Click/Ctrl+Click 
to choose these options from the context menu (or use the app's "Keyboard Short-
cuts").

Drag and Drop IRs
It is possible to drag and drop single, or multiple, .wav files from your computer’s desk-
top or file window directly into the IMPULSES list view to import them at once. You 
can also drag and drop from the IMPULSES list view directly to your computer to do 
an export.
It is also possible to drag and drop IRs within the IMPULSES list view to create a copy 
of the IR in a new index location. Please note that you cannot move or swap IRs in a 
single operation, thereby reducing the risk of unintentionally breaking the link of a spe-
cific IR index and its corresponding Helix preset. Use the Clear function to remove IR 
files from your Helix device's memory if they are no longer needed.

Loading an IR in an IR Block
Once you've inserted an IR type block in your preset's signal flow, you can load an IR 
file from your IR library in one of two ways:

• Select the IR block within the Helix app's signal flow, then, in the Home tab 
of the EDITOR Window, click the Impulse Response Menu and select the 
desired IR file.

• Click on the desired IR within the LIBRARIAN - Impulses list and drag & drop 
it directly onto the Impulse Response Menu within the Home tab.
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Editor Window
The EDITOR window is where you'll see the signal flow for your currently-loaded preset, appearing much like the screen on your Helix device. If you have not already done so, be 
sure to read through the in-depth information in the Helix User Manual to get an understanding of the features we'll be covering in the following sections.
The EDITOR window contains 4 tabbed panels, Home, Bypass Assign, Controller Assign & Command Center, where you can get down and dirty with customizing all aspects of 
your signal flow, tweaking block parameters, configuring controllers, MIDI assignments and more. Regardless which of these 4 tabs you have selected, the Snapshots, Save & Tap 
Tempo options are always available at the top of the EDITOR window. 

Current Preset 
Title

Preset Save 
Button

EDITOR Window 
Tab

GLOBAL EQ 
Window Tab

Snapshot 
Controls

Tap Tempo 
Controls

Panel Tab 
Selectors

Signal Flow

Lower Panel 
Display

http://line6.com/support/manuals/
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Configuring & Managing Snapshots
It is possible to configure up to 8 snapshots within a preset, allowing you to recall a 
customized set of options for your current blocks instantly, without the brief lag time 
associated with changing presets! A snapshot is capable of storing the bypass state 
of any amp or effects block, up to 64 assigned parameter values, tempo settings and 
more (please see the Helix User Manual for specifics). 
To configure a snapshot within the Helix app, click on the Snapshots combo-box and 
select the numbered snapshot you want as your destination, then configure all desired 
options for this snapshot.*

Snapshots 
Camera Icon 

Snapshots 
Combo-box

*NOTE: You can use your device's Global Settings > Preferences > Snapshot 
Edits to choose between Recall (automatically stores your changes to the 
current snapshot) versus Discard (does not store changes to the current 
snapshot). The camera icon is displayed in red  when set to Discard.

Copying, Pasting & Renaming Snapshots
Click directly on the camera icon to access these snapshot commands. Also note that 
you can utilize the keyboard shortcuts for these commands, as displayed in the menu 
(also see page 16).

To Copy & Paste a Snapshot - Select and load the snapshot you wish to copy 
from the Snapshots combo-box and select Copy Snapshot from the camera icon 
menu to copy it to the clipboard. Then select and load the snapshot you wish to 
overwrite from the Snapshots combo-box and choose Paste Snapshot from the 
camera icon menu to paste the clipboard contents into the loaded snapshot. 
To Rename a Snapshot - Click the desired snapshot from the Snapshots combo-
box and select Rename Snapshot from the camera icon menu to type in your new 
name, then press Enter/Return on your keyboard. Alternatively, you can "long-
click" (left-click and hold mouse button down for about 2 seconds) directly on the 
current Snapshot's name in the combo-box to edit it.

Snapshots Camera Icon 
and Expanded Menu 

NOTE: Remember that you'll need to Save before switching to another preset to 
retain your edited snapshot settings within the current preset! The snapshot that 
is in use when you save your preset is the one that is recalled when the preset is 
loaded again.

Saving the Preset
Whenever you see your preset's title appearing in italicized text and with an aster-
isk (e.g. - GuitArmageddon*) at the top of the EDITOR window, it is telling you the 
preset has been edited from its last-saved state. The Save button at the top right of the 
EDITOR window (or using the Cmd-S/Ctrl-S shortcut) can be used to instantly save the 
currently-loaded preset to the Helix hardware's internal memory. As covered in "Pre-
sets Panel" on page 4, there are also the LIBRARIAN window options, Copy and 
Export, to create & store copies of your presets.

Editing the Tap Tempo
There are a few options available for configuring the tempo, accessible from the con-
trols at the top of the EDITOR. Any of the current preset’s effect models set to note 
division values (time sync mode is available for most delay and modulation effects) will 
follow this Tap Tempo value.

Numerical Tempo 
Field

Tempo Select 
Menu Tap Tempo 

Button

How the Tempo Value is Recalled
Use the Tempo Select Menu to select how the tempo value is saved and recalled (this 
is the same option found in your Helix hardware's Global Settings > MIDI/Tempo 
screen):

• Per Snapshot - The tempo value will be stored and recalled individually per 
snapshot for this preset.

• Per Preset - The tempo value will be stored and recalled individually with this 
preset.

• Global - The tempo value is used for all presets whenever set to Global.

Entering a Tempo Value
To enter a value, click on the Tap button (or tap the T shortcut) rhythmically. Or, click 
directly within the Numerical Tempo Field and edit the value with your precise number.

http://line6.com/support/manuals/
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Home Panel
The Home panel is likely where you'll spend the most time, since it provides access to 
all aspects of your preset's signal flow at the top, and displays all editable parameters 
for the currently-selected block at the bottom. The options offered here are the same 
as found in the "inspector" across the bottom of your device's screen, making editing 
very straight-forward. 

Model List 
Menu
Model 
Bypass

Parameters

Adding, Clearing & Bypassing Blocks
To add any type of block to your tone, simply hover your mouse cursor over the desired 
location on any path and you'll see an empty block location appear. Once you select 
the location, choose any type of block from the Model List Menu in the lower portion 
of the Home panel. 
To clear any existing block, hover your mouse cursor over the block and click the red 
"X" that appears, hit your Delete key, or select Clear from the block's (Ctrl-Click or 
Right-Click) context menu.

To toggle the bypass of any block, click the Bypass toggle button that appears above 
the block when hovering over it, or select the block and hit your spacebar. Alternatively, 
a Model Bypass button also appears for the selected block in the lower panel display.

Bypass Toggle Clear Button

Moving Blocks & Arranging the Signal Flow
To move blocks within a signal path, simply click and drag any block to its desired loca-
tion. To follow are a number of pointers for arranging the signal flow in different ways.

Split Paths - To create a split path, simply drag a block down from the main sig-
nal path and you'll see a parallel, split path (Path B) appear, with both a Split and 
Merge block created at each end. To remove the split path, clear or move all blocks 
out of the parallel path.
Split and Merge Blocks - Note that you can click directly on these Mix blocks of 
a split path and drag to move them as desired as well. When selected, you can 
choose from among the types of Split and Merge blocks, as well as edit their op-
tions.
Path 1 / Path 2 - Just like on the hardware, it is not possible to move a block be-
tween Path 1 and Path 2, but you can copy a block and then paste into any desired 
location on the opposite path to duplicate it there along with all its current settings 
- see next section. 

Copying & Pasting Blocks
To copy a block, along with all its current parameter settings, click on the block to select 
it, then either Ctrl-Click/Right-Click and choose Copy from the context menu (or use 
the Cmd-C/Ctrl-C keyboard shortcut). To paste, click to select your desired destination 
and choose Paste from the block's context menu (or Cmd-V/Ctrl-V). To follow are a few 
handy copy & paste tips.

Paste Location - You can paste into either an "empty" block location or one that 
is already occupied by another block. If already occupied, this will replace the 
existing block. 
Mix Type Blocks - Copy & paste are also available for Input, Output, Split and 
Merge block types too, where the settings from one of these blocks can be copied 
& pasted into a location with the same block type.

NOTE: Only one Looper block can exist within any preset at a time. 
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Editing Model Parameters
As you've likely discovered by now, there are several types of blocks that can be utilized 
in any preset: Amp, Preamp, Cab, Impulse, Effect, Looper, Split, and Merge. Once 
added to your tone, simply click on any block to select it, and then you'll be able to 
choose the desired model type and tweak its parameters in the lower display pane of 
the Home panel. To follow are a few editing tips (also see "Keyboard Shortcuts").

Adjusting Sliders - Obviously, you can drag a slider to edit its value, or you can 
alternatively click the up/down arrow buttons at the right of the slider or tap your 
comma & period keys for small, incremental adjustments (add the Shift key for 
large adjustments). Also try a Ctrl-Click or Right-Click on a slider to manually type 
in a precise numerical value.
Resetting Sliders - If you're not happy with your slider adjustment, Ctrl-Click on 
the handle of the slider to reset it to its default value. 
Accessing All Controls - Note that some model types, such as amps and com-
plex effects, may have more sliders and controls than you can see all at once in 
the lower display pane. Use your mouse wheel or the vertical scroll bar in the lower 
pane of the Home panel to get to all available options.

Editing Inputs & Outputs
Much like amp & effects blocks, you can click on the input and output blocks of any 
path and access their options in the lower display pane of the Home panel. You'll 
find different parameters depending on the type of input or output you select from the 
menu, such as Gate, Level, Pan, etc. 
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Bypass Assign Panel
This panel offers the same options found within the Menu - Bypass Assign screen on 
your Helix device, allowing you to assign any block's bypass toggle function to a foot-
switch on your Helix device, as well as customize the associated footswitch's scribble 
strip. 

Currently 
Selected 
Model

Footswitch 
Menu

Footswitch 
Options

Creating a Bypass Assignment 
Click on the Bypass Assign tab (or tap "B") to view this panel and select the block 
within the signal flow for which you want to assign its bypass toggle to a footswitch. In 
the lower display pane, simply click the Footswitch Menu to select the desired foot-
switch and your assignment is created. 

Bypass Assignments for Multiple Blocks
For the Helix hardware, you can only assign the bypass toggle of a particular block to 
one footswitch at a time. But it is possible to assign the bypass function for multiple 
blocks to one, common footswitch. It is also possible to create additional Controller & 
Command Center assignments on footswitches that include Bypass Assignments, as 
well as to create Snapshots that include multiple bypass & other parameter changes all 
in one click - see the respective chapters for more on these assignment types!

Latching Option
For amp & effects models, you'll also find the option here to have the assigned foot-
switch behave as Latching (alternating On/Off on each click) versus Momentary (active 
only while the footswitch is held down).

Switch LED Color
By default, the color of the LED light surrounding your assigned footswitch is set to 
Auto Color, where it intelligently takes on the color according to the assigned model 
type. You can use this slider to manually configure this LED color as desired. 

Customizing a Scribble Strip Label
Once you create a Bypass Assignment for the selected block, you'll see the Custom 
Label field display the block model's default name - which is also displayed on the 
hardware's scribble strip for this footswitch (when Helix is in Stomp Footswitch 
Mode). If you want to customize this label, simply type your new name in the field and 
hit your Enter/Return key. To clear your text and return to the default model label, click 
the Remove button to the right of the field. 

NOTE: If a footswitch includes additional block Bypass, Controller or Command 
Center assignments, the default label appears as Multiple (X)" with "X" being 
the number of assignments. You can customize the label in this scenario, but 
note that it can also be customized within the Custom Label field of the other 
assignment panels as well, with the latest customization edit affecting the label 
in all places. 
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Controller Assign Panel
This panel offers options found within the Menu - Controller Assignments screen of 
your Helix device, allowing you to assign model parameters to an expression pedal, 
Variax knob, footswitch or MIDI CC for real-time, remote control. It is also possible here 
to assign model parameters' values to be included when recalling a snapshot.

Currently 
Selected 
Model

Parameter 
Selector

Controller 
Options

Controller 
Menu

Creating a Controller Assignment
Click on the Controller Assign tab (or tap "C") to view this panel and select the block 
within the signal flow which contains the model parameter you wish to control. In the 
lower portion of the panel, use the Parameter Selector to choose the desired param-
eter, then click the Controller Menu to choose the controller type (Exp. Pedal, Variax 
knob, Footswitch, MIDI CC or Snapshot) that you want to use to control this parameter.

Minimum Value & Maximum Value
Use the Minimum Value & Maximum Value sliders to set the range of control. For ex-
ample, if assigning to an Exp. Pedal, the Min. Value would be your "heel down" value, 
and the Max. Value would be the "toe down" value. If assigning to a footswitch, toggling 
the switch would choose between your Min. & Max. values. (Note that if assigning to a 
snapshot, all you need to do is set the single parameter value you wish to be recalled 
with the currently-loaded snapshot.)

Multiple Controller Assignments
Just as on the hardware, you can only assign a parameter to one controller at a time. 
However, it is possible to assign multiple parameters to one common controller, (for ex-
ample, to simultaneously control the Mix parameters of two effects with an exp. pedal 
to blend between them). It is also possible to create additional Bypass & Command 
Center assignments on footswitches that also include Controller assignments - see the 
respective chapters for more on these assignment types.

Latching Option
When a Controller assignment is mapped to a footswitch, you'll see the option here 
to have the assigned footswitch behave as Latching (alternating Min./Max. values on 
each click) versus Momentary (Min. or Max., opposite of the value currently in use,  
while the footswitch is held down).

Customizing a Scribble Strip Label 
When you create a Controller assignment to a footswitch for the selected parameter, 
you'll see the Custom Label field display the parameter's default name - which is also 
displayed on the hardware's scribble strip for this footswitch (when Helix is in Stomp 
Footswitch Mode). If you want to customize this label, simply type your new name in 
the field and hit your Enter/Return key. To clear your text and return to the default pa-
rameter label, click the Remove button to the right of the field.

NOTE: If this footswitch includes additional block Bypass, Controller or Com-
mand Center assignments, the default label appears as Multiple (X)" with "X" 
being the number of assignments. You can customize the label in this scenario, 
but note that it can also be customized within the Custom Label field of the 
other assignment panels as well, with the latest customization edit affecting the 
label in all places. 

Clearing Controllers
Also found in the options of this screen are two handy buttons for clearing Controller 
assignments with a single click:

Clear Block Controllers - Removes all Controller assignments for the currently 
selected block. 
Clear All Controllers - Removes all Controller assignments for the current preset.
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Command Center Panel
This panel offers the options found within the Menu - Command Center screen of your 
Helix device, allowing you to create MIDI & CV output assignments to remotely control 
other gear.

Command
Menu

Control 
Selector

Parameters

Creating a Command Center Assignment
Click on the Command Center tab (or tap "M") to view this panel and click within the 
Control Selector to select the (instant , footswitch, exp. pedal or Variax knob) item 
to which you want to map an assignment. Then in the lower portion of the screen, click 
on the Command Menu to choose the type of message you wish to transmit from this 
control. Once a command type is selected, configure all its options using the param-
eters that appear within the lower display pane. 

You'll see a turquoise triangle above the control items here indicating those that include 
an assignment. To remove an existing assignment, simply select the control item again 
within the Control Selector and choose None from the Controller menu.

Assignment Indicators

Copying, Pasting and Clearing Commands
Just as on your Helix device, there are commands available to easily Copy, Paste and 
Clear Control Center assignments. Using these menu commands, you can copy and 
paste an assignment from one controller to another, copy & paste all Control Center 
assignments within the current preset to another preset, clear the current controller as-
signment, or clear all the preset's current Control Center assignments.

To Copy or Clear - Simply Right-Click/Ctrl-Click in the lower portion of the screen 
on the desired instant , footswitch, exp. pedal or Variax knob controller item that 
includes the assignment and choose the command from the context menu. 
To Paste - Once you've copied Command Center assignment data to the clip-
board, Right-Click/Ctrl-Click on your desired destination controller item (within the 
same preset, or in another) and choose the Paste or Paste All option. 

Configuring Unique Assignments Per Snapshot
It is possible to configure your Command Center assignments with some command 
types and/or values that differ within each snapshot, allowing a great deal of message 
variety possibilities within a single preset. Please refer to the Helix User Manual for 
details on the types of Command Center messages that can be stored & recalled with 
a snapshot, and their specific behaviors.

http://line6.com/support/manuals/
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To store your assignment settings within a snapshot, simply select the desired snap-
shot number from the Snapshots combo-box at the top of the EDITOR window, and 
then edit the eligible values of your existing Control Center assignments that you wish 
to be stored within it. (Also see "Configuring & Managing Snapshots" on page 8.)

Customizing a Scribble Strip Label
When you create a Command Center assignment to a footswitch control, you'll see 
the Custom Label field appear within the parameter section of the lower display pane, 
showing the control type's default name - which is also displayed on the hardware's 
scribble strip for this footswitch (when Helix is in Stomp Footswitch Mode). If you 
want to customize this label, simply type your new name in the field and hit your Enter/
Return key. To clear your text and return to the default label, click the Remove button 
to the right of the field.

NOTE: If this footswitch includes additional block Bypass, Controller or Com-
mand Center assignments, the default label appears as Multiple (X)" with "X" 
being the number of assignments. You can customize the label in this scenario, 
but note that it can also be customized within the Custom Label field of the 
other assignment panels as well, with the latest customization edit affecting the 
label in all places. 
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Global EQ Panel
The GLOBAL EQ Panel offers a large graphical interface for the Helix device's Global 
EQ (which is found from your hardware's Menu button and selecting Global EQ). As 
its name suggests, the Global EQ settings and bypass state are indeed global and not 
saved or recalled with any preset or snapshot. 

Apply EQ
Output Menu

Graphical 
Display

Reset Button

Bypass Button

Parameter 
Pane

Adjusting Global EQ Parameters
The GLOBAL EQ panel offers two panes in which you can view & adjust its settings. 
The EQ processing is active whenever its Bypass button is set to "On" in this panel (or 
via your device's Bypass button when viewing its Global EQ screen).

Graphical Display - Click and drag the edit "handles" in the upper graph to adjust 
a band's frequency and amplitude. You'll see the respective parameters' sliders 
move within the lower pane while adjusting the handles.
Parameter Pane - There are several ways to adjust the controls (also see "Key-
board Shortcuts" on page 16):
• Click and drag any slider's handle or use the Up/Down buttons at the right of 

each slider
• Ctrl-Click/Right-Click on a slider to enter a precise value numerically 
• Turn your mouse wheel while hovering your cursor over any slider
• Click on a slider and use the comma/period or -/+ shortcut keys to incremen-

tally adjust its value 
• Cmd-Click (Mac®) /Ctrl-Click (Windows®) on a slider to individually reset it to its 

default value

Bypass Button - Toggle the Bypass to globally enable or disable the EQ.
Reset - Click the Reset button to instantly return all parameters to their default, 
"flat" values (or Cmd-Click/Ctrl-Click directly on any individual slider). 
Apply EQ Output Menu - Select the output(s) on which you want the Global EQ to 
be active: 1/4-inch, XLR or 1/4-inch + XLR.

TIP: Use the Level parameter either as a "make-up gain" to compensate for the 
overall output level change incurred by EQ parameter settings.
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Keyboard Shortcuts
The following keyboard shortcuts are available to speed up tasks when working in the Helix application. Where indicated, some shortcuts require that "focus" be placed on a panel 
or specific control to be able to trigger its function. To place focus within the desired tabbed panel, either click within the panel, press your Tab key to cycle focus between the 
LIBRARIAN & EDITOR windows, or select the desired panel from the application's Window menu. You'll see a blue outline indicating the panel that currently has focus. To select a 
block or slider, click directly on it, or use the Up/Down and Left/Right arrow key to navigate through blocks in the EDITOR window.

Keyboard Shortcuts
Mac® Windows® Function

Toggles focus between the LIBRARIAN and EDITOR windows

Displays and places focus on the LIBRARIAN window - PRESETS panel

Displays and places focus on the LIBRARIAN window - IMPULSES panel

Displays and places focus on the EDITOR window - Home panel

Displays and places focus on the EDITOR window - Bypass Assign panel

Displays and places focus on the EDITOR window - Controller Assign panel

Displays and places focus on the EDITOR window - Command Center panel

Displays and places focus on the EDITOR window - GLOBAL EQ panel

Saves the currently loaded preset

Enters a tap tempo value

Selects and cycles through amp blocks in the current preset

Toggles the bypass state of currently-selected block
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Keyboard Shortcuts

Mac® Windows® LIBRARIAN Window Function
(Requires focus within Librarian)

EDITOR Window Function
(Requires focus within Editor)

Navigates next/previous preset or impulse 
Navigates items in any expanded menu

Navigates up/down to select blocks within signal flow 
Navigates items in any expanded menu

No function Navigates left/right to select blocks within signal flow

Loads currently-selected preset in PRESETS list, or 
currently-selected item within an expanded menu
No function within IMPULSES tab

Loads currently-selected item within an expanded menu

 or 
Clears currently-selected IR in IMPULSES tab
No function within PRESETS tab

Clears currently-selected block within signal flow

 or  or 
No function Increments the last-selected parameter slider's value, in 

small steps

 or  or 
No function Decrements the last-selected parameter slider's value, in 

small steps

 
+ 

 or

 
+ 

 
+ 

 or

 
+ 

No function Increments the last-selected parameter slider's value, in large 
steps

 
+ 

 or

 
+ 

 
+ 

 or

 
+ 

No function Decrements the last-selected parameter slider's value, in 
large steps

Copies the currently-selected preset or IR to the 
clipboard

Copies the currently-selected block (amp, cab, IR, input, 
output or mix block types) to the clipboard

Pastes the last-copied preset or IR from the clipboard 
into the selected preset or IR librarian list slot

Pastes the last-copied block from the clipboard into the 
selected block position within the signal flow

To Import a preset or IR into the currently-selected 
librarian list slot

No function

To Export the currently-selected preset or IR No function
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Keyboard Shortcuts

Mac® Windows® LIBRARIAN Window Function
(Requires focus within Librarian)

EDITOR Window Function
(Requires focus within Editor)

To Rename the selected preset or IR in the Librarian 
list

No function

No function Copy the currently loaded snapshot to the clipboard

No function Paste the copied snapshot (clipboard contents) to the 
currently loaded snapshot

No function Rename currently loaded snapshot

Click on any preset or IR for context menu options 
(Copy, Paste, Import, etc.) 

Click directly on any block's parameter or controller slider to 
edit its value numerically
Click on any block for context menu options (Copy, Paste, 
Clear) 

  

Multi-select presets or IR locations in the librarian lists Click on any parameter slider to reset it to its default value

Mouse Wheel Behaviors
If your mouse happens to have a mouse wheel, there are several handy functions you can access with it in the app. Just turn the mouse wheel when hovering over the following items:

• To vertically scroll the LIBRARIAN window's PRESETS and IMPULSES lists
• To vertically scroll the parameter sliders within the EDITOR window's lower panel display
• To vertically scroll through open model or parameter drop-down menus within the EDITOR window's lower panel display
• To adjust any of the parameter sliders within the GLOBAL EQ panel
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Application Preferences
It is possible to configure a few application preferences, if desired. To get there on 
Mac®, select Helix > Preferences from the application's main menu. On Windows®, 
select File > Preferences.

Preset Numbering Format
Presets in Helix can be numbered as bank numbers & letters or by 000-127 (corre-
sponding to MIDI) depending on which is more convenient for you. This setting will also 
sync or modify the Helix device's setting. You can also find this Preset Numbering 
option in your Helix device’s Global Settings > Displays.

Stereo IR Import
When a stereo .wav file is imported as an IR by the Helix application, it must be con-
verted to mono. This preference lets you choose whether to take the left or right chan-
nel, or to sum them to mono. The default is to import the left channel.
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Line 6 Updater & 
Additional Resources

Using Line 6 Updater
Line 6 Updater is the utility to use to easily install the latest firmware images onto Line 
6 products. Line 6 Updater is installed automatically on your computer with the instal-
lation of the Helix application - or it can be downloaded anytime from http://line6.com/
software/

TIP: It is always a good idea to create a backup of your Helix contents before 
performing a firmware update - See "Importing and Exporting Helix Bundles" on 
page 5.

To run Line 6 Updater - With Helix connected and powered on, quit all other Line 6 and 
audio applications and launch Line 6 Updater.

•	 On Mac® - go to Applications > Line 6 > Line 6 Updater
•	 On Windows® (XP, Vista, 7/8) - go to the Start button menu > Programs > Line 

6 > Line 6 Updater
•	 On Windows® (10) - go to the Start button menu > All Apps > Line 6 > Line 6 

Updater

Once launched, you will be asked to sign into your Line 6 account. If you do not have 
an account, you must first create one. Follow the prompts through to the quick online 
registration.
Once logged in, any USB-connected and supported Line 6 products will appear in the 
main view of Line 6 Updater. Click on the device you wish to update and your device's 
current firmware version and available updates are displayed.

Click the Update button for the desired firmware version. The release notes are shown 
before continuing with the update process. Click Accept and accept the terms and 
conditions to start the update process.
There may be some instructions displayed before update begins. Be sure to read the 
prompts carefully and Line 6 Updater will assist you in performing the update in min-
utes. It is especially important not to disturb the device’s controls and cable con-
nections until the update fully completes!
While the presets on your Helix device will not be altered, some minor sonic changes 
may still occur with firmware updates. 

Additional Resources
Looking for more info? We’ve got plenty of online resources, just a click away.

• Additional Help documentation covering Helix is available on the Line 6 Support 
site at Line 6 Product Manuals 

• Visit the Line 6 Customtone™ site where you can share your Helix presets with 
the world, and download free presets created by Line 6 and other users just 
like you.

• Can’t get enough Line 6 Gear & accessories? Head on over to the Line 6 Store.
• Check out the Line 6 Support page for access to helpful tips, videos, discussion 

forums, or to contact Line 6 Technical Support.
 

http://line6.com/software/
http://line6.com/software/
http://line6.com/support/manuals/
http://line6.com/customtone/
http://store.line6.com/
http://line6.com/support
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